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TECHNICAL ASSISTANCE
DELISTING RISK ASSESSMENT SOFTWARE (DRAS)
VERSION 4.0

1.0 INTRODUCTION

The Delisting Risk Assessment Software (DRAS) is an efficient tool developed by U.S.
Environmental Protection Agency (EPA) Region 6 to provide a multipath risk assessment for the
evaluation of Resource Conservation and Recovery Act (RCRA) hazardous waste delistings. EPA
Regions, numerous authorized states, and facilities’ consultants have been using DRAS to evaluate
delisting petitions. The 2008 version (DRAS 3.0) has problems running on newer operating
systems (OS) as it was on a platform that is now obsolete. EPA Region 7 tasked HydroGeoL ogic,
Inc. (HGL) to provide technical assistance to EPA Region 5 relating to the new release of DRAS.

1.1 OBJECTIVES

The objective of this Task Order is to prepare, test, and document the new release of DRAS, DRAS
version 4.0. DRAS methodology will be updated, additional constituents will be added to the
database, and sortable tables and the ability to add custom chemicals will be included.

1.2 REPORT ORGANIZATION

Background information relating to DRAS is presented in Section 2. User’s guide is provided in
Section 3. References are given in Section 4. An application example is given in Appendix A.

U.S. EPA Region 5
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Delisting Risk Assessment Software Version 4.0

20 BACKGROUND

This section presents a brief review of the current DRAS (version 3) and a comparison between
DRAS 3 and DRAS 4. The current DRAS and its shortcomings are presented and discussed in
Section 2.1. Improvements of DRAS are discussed in Sections 2.2 and 2.3.

2.1 DELISTING RISK ASSESSMENT SOFTWARE VERSION 3 (DRAS 3.0)

The EPA Region 6 Delisting Program developed a computer-based program called DRAS (EPA,
2008) to evaluate delisting petitions in a timely manner. DRAS performs two types of analyses to
analyze the multi-pathway risks and hazards posed by the constituents of a waste petitioned for
delisting: screening-level analyses and aggregate risk and hazard analyses. The screening-level
analyses compute chemical-specific exit values or “delisting levels” for multi-year delistings. The
aggregate risk and hazard analyses compute the aggregate carcinogenic risk and noncarcinogenic
hazard indices for a waste petitioned for a one-time delisting. The delisting levels and aggregate
risk and hazard estimates are calculated using modeled, medium-specific chemical concentrations
and standard EPA exposure assessment and risk characterization algorithms. The results of these
analyses may be viewed on screen, imported directly to word processing software, or printed in
document-ready form to allow end users to incorporate the results into their documents and/or
archive the results.

DRAS 3.0 is a Windows-based desktop application. It was developed based on the legacy Visual
Basic (VB) 6.0 code. DRAS has three distinct components: a Graphical User Interface (GUI), a
database, and a risk computational engine that comprises several risk components. The GUI and
the risk computational engine are coded in VB 6.0. The database, which is based on Microsoft
Access, contains constituent-specific biological, physical, and chemical properties and risk-related
parameters for different types of receptors. DRAS users input site information and select chemicals
of concern (COCs) through the GUI. The site information and selected COCs are stored in the
database. Risk analyses are then performed using the imbedded VB computational risk engine.
New constituents (constituents not in the database) can be appended to the COC database. Results
are viewable on screen. An electronic report is generated at the end of each analysis.

The current DRAS has several weaknesses, listed below:

e Incompatible with newer Windows OSs (Windows versions after Windows XP) and
Windows XP with different Microsoft Service Packs at some sites.

e Lacks the capability to sort rows and columns of the database through the GUI.
e Developed based on VB 6.0, which has the following disadvantages:
0 Obsolete and no longer supported by Microsoft.

0 Requires many dynamic link libraries (DLLS) to be present. Some of the DLLs may
conflict with those required by other software. The DLLs required by different
software may have conflicting names and versions in Windows Registry.

0 Computationally inefficient.

U.S. EPA Region 5
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2.2 DELISTING RISK ASSESSMENT SOFTWARE VERSION 4 (DRAS 4.0)
2.2.1 Features of DRAS 4.0

To ensure the longevity of the new DRAS, each of its components (GUI, database, and risk
computational engine) is now independent so that it can be maintained and updated independently.
The attributes of each component of DRAS 4.0 are summarized below.

Graphical User Interface (GUI)

e Independent of the database and the risk computational engine,

e Allows the users to input site and COC information and sort the database, and

e Developed based on the Python language that is widely adopted in current development
by major software companies and will not be obsolete in the near future.

Risk Computational Engine

e Independent of the GUI and the database,
e Provides output that can be verified step-by-step, and
e Developed based on the Fortran language that is suitable for scientific computing.

Data Store

e Independent of the GUI and the risk computational engine,

e Based on a technology, SQLite, that is in the public domain, widely used and well
supported,

e Possesses sufficient features, and
e Has suitable scalability and stable performance.

2.2.2 Changes in Risk Engine

There is one change in calculating atmospheric emission risk due to surface impoundments. Based
on the plug-flow theory, the relationship between the initial concentration, Ci, and liquid
concentration, Cy, at time t is (from Equation (5-9) in EPA (1994)):

C, = Cl-exp( ‘Zw) (2-1)

where:

CL = equilibrium liquid concentration in the surface impoundment (m/L?),

Ci = initial liquid concentration to the surface impoundment (m/L?),

K = overall mass transfer coefficient (m/T),

A = surface impoundment surface area (L?),

t = time (T), and

Vsi = volume of surface impoundment (L3).

U.S. EPA Region 5
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Mass left in the tank after time t is C. Vsi, therefore, the total volatilized mass is:

St

(Ci—C Vs =G (1 — exp (ﬂ)> Vsi

Equating total mass over a period of T, using Equation (2-2), one obtains

G, (1 ~ exp (‘Zf)) V= QT

where:
Qv = maximum permissible volatile emission rate (m/T)

which leads to:

T
Cl QV

Vi (1—exp(_§2T)>

T is determined from the following conditions:

trzﬁ

Q
tr = —In(0.01) L
= n(vu. XA
T = Min (tf, tr)

where:
tr = retention time (T)
s = time at which exp (%) (Equation (2-1)) is equal to 0.01 (T).
Q = surface impoundment exfiltration rate at the bottom (L%/T).

(2-2)

(2-3)

(2-4)

(2-5)
(2-6)
(2-7)

Ciis equivalent to Cqi-air-si, delisting inflow concentration due to atmospheric emission from surface
impoundment in Equation (4-58) in EPA (2008). The exfiltration rate per unit area in Equation
(2-5) is set at 0.0972 m3/year/m? which is a geometrical average of the 95" percentile of exfiltration
rates from three types of surface impoundment liner (unlined, single-lined, and composite-lined)

in EPA (2003).

U.S. EPA Region 5
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3.0 DRAS4SOFTWARE: OVERVIEW AND USER’S GUIDE

DRAS was specifically designed to help determine whether a waste meets the conditions under
Title 40 Code of Federal Regulations 40 CFR 8§261.11(a)(3) (Criteria for Listing Hazardous
Waste), a requirement for evaluating proposed hazardous waste exclusions (delisting). DRAS also
assists in evaluating other factors pertinent to the waste including chemical constituents other than
those for which the waste was listed that could cause the waste to remain hazardous. DRAS 4 will
assist the user in applying DRAS to evaluate petitions to delist hazardous wastes submitted under
(40 CFR) §260.22.

DRAS performs a multi-pathway and multi-chemical risk assessment to evaluate the acceptability
of a petitioned waste to be disposed in a Subtitle D landfill or surface impoundment instead of
under RCRA Subtitle C requirements. For landfills, DRAS models a mismanagement scenario at
an unlined Subtitle D landfill where releases to groundwater are not controlled and 30 days of
waste is always left uncovered at the surface, subject to air emission and runoff. DRAS uses
leachate analysis of the waste to model exposure of nearby residents to impacted groundwater via
ingestion, shower-inhalation, and dermal exposure. Using totals analysis of the waste, DRAS
models exposure of nearby residents to surface water and fish ingestion impacted by runoff,
inhalation of particulate and volatile emissions from the uncovered waste, and incidental ingestion
of residential soil contaminated by settled particulate emissions from the waste.

For surface impoundments, DRAS models a subtitle D surface impoundment with uncontrolled
volatile emissions and groundwater releases. DRAS uses leachate analysis of the waste to model
exposure of nearby residents to impacted groundwater via ingestion, shower-inhalation, and
dermal exposure. DRAS also uses leachate analysis of the waste to model exposure of nearby
residents to volatile emissions from the surface of the impoundment. No totals concentrations are
required for evaluating surface impoundments.

DRAS executes both forward- and back-calculations. The forward-calculation uses chemical
concentrations exhibited by the petitioned waste and the annual volumetric rate of waste generation
to estimate cumulative carcinogenic risks and noncarcinogenic hazards from disposal as a non-
hazardous waste. The back-calculation uses target risk and hazard criterion set by the regulatory
authority to estimate chemical concentrations in the petitioned waste that would not pose an
unacceptable increase in risk and hazard.

DRAS 4 was developed in such a way that it is simple to apply by users with little background in
risk assessment. The user enters a few simple input parameters, selects COCs from a list, and
enters COC concentrations. Then after running a few steps (see Section 3.3.2), the program
generates output with forward-calculations of risk and hazard and back-calculations of maximum
allowable concentrations. DRAS can also be used as a tool to establish analytical reporting limits
for use in the delisting petitioner’s quality assurance project plan and/or sampling plan. Even with
no actual data available, DRAS can be run with zeros entered for concentrations. Maximum
allowable concentrations based on the target risk and hazard will be derived for the most
conservative limiting pathway and can be used a basis for determining detection limits.
Specifically, DRAS output Table 8, Limiting Pathways, identifies the most conservative maximum
allowable concentrations and can be used for determining target detection limits for a delisting
petitioner’s quality assurance project plan and/or sampling plan.

U.S. EPA Region 5
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An overview and a user’s guide of DRAS 4 are given in this section. An application example is
presented in Appendix A.

3.1 DRAS4DEPLOYMENT

DRAS 4 can be easily installed by copying the DRAS 4 executable to a working directory. The
DRAS 4 executable can be activated from any working directory. By double clicking on
DRAS_4.exe (or executing from a command line), a window with two tool bars as shown in Figure
3.1 will appear.

W7 DRAS40 - O x
File Edit Run Help
New Import Saveas Bxport Pefitioner Createinput Run Results Report Manual About

Figure3.1  DRAS 4 Main Window

3.2 DRAS4TOOLBARS

As shown in Figure 3.1, the DRAS 4 upper toolbar has the following options:

File
Edit
Run
Help

3.2.1 File Options

The overall approach to project files in DRAS 4 is structured around establishing project-specific
file folders. Some of the interim files needed to run and document DRAS are auto-generated with

U.S. EPA Region 5
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the same name for every run and cannot be customized while in use. These include the DRAS 4
input file, DRAS.IN, the output file, DRAS.OUT, and some of the output reports. If the user wishes
to save unique copies of these files for reuse, these files must be stored in unique project folders.

In the dropdown menu shown in Figure 3.2, File has the following options:

New
Import
Save as
Export
Exit

Figure 3.2  Dropdown Menu of File

New Choosing New opens a worksheet into which waste manage unit information is
entered.
Import This option allows the user to import information from a previous analysis, saved

as an SQLite file. Note: to successfully run an imported saved file, a new DRAS
4 session must be initiated by exiting the software (if open for previous runs) and

restarting.
Save as This option saves the current analysis as an SQL.te file.
Export This option exports the current analysis in csv files. Csv, or comma separated

values files, are easily imported into spreadsheets such as MS Excel. The export
function generates four csv files:

e [filename]_Wmu.csv  Includes the waste management unit inputs like
volume, unit type, years active, etc.;

U.S. EPA Region 5
3-3



Delisting Risk Assessment Software Version 4.0

Exit

e [filename]_Sitecocs.csv  Includes the concentrations and detection limit
status for all site COCs;

e [filename]_Petitionerinfo.csv Includes all the information from the
petitioner information tab; and

e [filename]_Cuscocs.csv Includes all parameter information for user-
generated customized chemicals of concern.

HINT: the [filename]_Cuscocs.csv file can be used to import user specific COCs
(often chemicals that are not already in the DRAS4 database) into new projects.

This option allows the user to exit the current analysis/project.

The above four options: New, Import, Save as, and Export, are also accessible from the lower

toolbar.

3.2.2 Edit Option

In the dropdown menu shown in Figure 3.3, Edit has one option:

e Petitioner

DRAS 4.0

I;:ile ' Edit: Run ﬁelp

I}lew

Figure 3.3

Petitioner

 Petitioner port : = Petitiol

Dropdown Menu of Edit

Choosing the Petitioner tab allows the user to enter information relating to
petitioner and waste stream. This includes EPA Region, a unique petition number
(if used), petitioner’s name and address, a description of the waste and
identification of RCRA waste codes, and information about the DRAS 4 user
including name and pertinent dates. A comment box is also provided.

The information in the Petitioner tab is optional and DRAS 4 will run without any
entries here. The information is recommended as it provides important project
details for generated project reports that may be used in the rue-making docket in
support of a delisting decision.

The above option is also accessible from the lower toolbar.

U.S. EPA Region 5
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3.2.3 Run Options

In the dropdown menu shown in Figure 3.4, Run has the following options:

Figure 3.4

Create input

Run

Results

Report

Create input
Run
Results
Report

Dropdown Menu of Run

This option creates input file DRAS.IN for the analysis. Note: this filename cannot
be changed before using the Run option below. This option will require selection
of a folder where the DRAS.IN file will be stored. Each time the Create input
option is selected, it will overwrite any existing DRAS.IN file in the selected folder.

This option allows the user to run the analysis based on the generated input file.
The option will require selection of a folder where the DRAS.OUT file will be
stored. Each time the Run option is selected, it will overwrite any existing
DRAS.QUT file in the selected folder.

This option allows the user to generate results in ten tables. Details about the output
tables are provided in Section 3.3.2.8.

This option allows the current analysis to be output in .pdf or .html formats. Note:
The reports generated by the Report tab will be limited to project input information
unless the Results tab has been opened at least once in the current run. Please run
the Results tab option before selecting Results to get complete .pdf and .html
reports.

The above four options are also accessible from the lower toolbar.

U.S. EPA Region 5
3-5



Delisting Risk Assessment Software Version 4.0

3.2.4 Help Options

In the dropdown menu shown in Figure 3.5, Help has the following options:

e Manual
e About
Manual This option allows the user to access the Delisting Technical Support Document

and the User’s Guide.
About This option provides information relating to DRAS 4.

The above two options are also accessible from the lower toolbar.
DRAS40
F“e i Ed,t = Run : .. :
New f?'Wt Sa;" Manual

Figure 3.5  Dropdown Menu of Help

3.3 DRAS4USER’S GUIDE
3.3.1 Starting the DRAS 4 software.

Installation of DRAS 4

DRAS 4 can be simply installed by copying DRAS_4.exe to a working folder where the executable
can be run.

Launching of DRAS 4

DRAS 4 can be then launched by double clicking on the executable file or executing it from a
command line window. The main window will appear as shown in Figure 3.1.

U.S. EPA Region 5
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3.3.2 Set Up a New Project and Run DRAS 4

3.3.2.1 Set Up a New Project

New Project

A new project is initiated by clicking on New from the toolbar or selecting File > New from the
dropdown menu. A window in the DRAS 4.0 dialog, shown in Figure 3.6, will appear.

o - & x
New Import Saveas Export Petiioner Createinput Run Results Report Manual About
Waste Management Unit Type  Waste Volume Risk/HQ Values
(® Landfil : Cancer RiskLevel [1e6 |
i Volume : Cubic Yards ~
O surface Impoundment Hazard Quotient | 1.0 -
Waste Management Unit Active Life Run with Detection Limit
@® 1YearBatch (O Multiple Year Batch Active Years 2 ®os Q1o
Add Cus. Add COCs Remove Row
Chunseil TCLp Is TCLP Conc. Total Is Total Conc. Property
Name Concentration a Detection Limit Concentration a Detection Limit Defalls
(mg/L) (COCis ND)? (mg/kg) (COCisND)?

Figure 3.6  New Project Window

3.3.2.2 Enter Waste Management Unit (WMU) Properties

WMU Properties

WMU properties are entered using the upper portion of the new project window in Figure 3.7
(demarcated by the upper dashed box). The following information is required:
e WMU type:
0 Landfill
0 Surface impoundment

e Waste volume, and select volume unit (Note: If the waste volume is not entered or is
equal to zero, the project to be terminated and the DRAS 4 session will end when
attempting to run.)

U.S. EPA Region 5
3-7



Delisting Risk Assessment Software Version 4.0

WMU active life: 1-year or multiple-year batch with number of years of active life in the
case of multiple years. (Note: If waste management unit active years field is blank at any
time, the DRAS 4 session will be terminated. We recommend that any intended changes
to the active years field be entered first adjacent to the existing value before those
numerals are deleted.) DRAS 4 default values for waste management unit active years
of 20 years for landfills and 50 years for surface impoundments are discussed in the
Delisting Technical Support Document.

Target cancer risk and noncancer hazard quotient values (determined by the delisting
regulatory authority). These values are used in the back-calculation of maximum
allowable concentrations. They will likely also be used separately by the delisting
regulatory authority to assess the overall risk posed by the waste stream.

As an option, the user can select a detection limit (DL) multiplier for including non-
detected constituents in the risk assessment. The options are to evaluate non-detected
constituents at either the full detection limit or one half of the detection limit (0.5 or 1.0)
in the forward calculation of risk and hazard. The inclusion of risk estimates from non-
detected constituents can provide a more conservative assessment of the petitioned waste
and serve as a qualitative check on the overall adequacy of the sampling and analysis. If
there is very little difference between the aggregate risk results from detected values only
and the aggregate risk including non-detects, then detection limits were likely adequate.
If aggregate risks are much higher when including non-detects, then it is likely that some
detection limits were not sensitive enough to assess the waste.

3.3.2.3 Set Up Site Chemicals of Concern (COCs)

Site COCs are determined by following the steps below, using the lower portion of the new project
window in Figure 3.7 (demarcated by the lower dashed box).

1.

To add COCs from the default database:

Click the Add COCs button (see Figure 3.7 lower dashed box), a new dialog box containing
all default COCs will be displayed (Figure 3.8). Select all applicable COCs by checking
the boxes in Column 3 - “Chemical name” - to select the project COCs.

Click the Save button to add the COCs to the main window.
Other Buttons on the Toolbar:

Clicking on Select All will select all the chosen COCs shown in the third box of the toolbar
(the pull-down field preceded by “in”).

Clicking on Clear All will deselect all the chosen COCs shown in the third box of the
toolbar.

U.S. EPA Region 5
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r_— = —— ]
| B )
IEﬂ : - & %
New Import Saveas Export Petitoner Createinput Run Results Report Manual About
: Waste Management Unit Type Waste Volume Risk/HQ Values
Landfill Cancer Risk Level | 1e-6
| . Volume: | Volume Cubic Yards g +|
| (O Surface Impoundment Hazard Quotient
I Waste Management Unit Active Life Run with Detection Limit
|. @ 1YearBatch (O Multiple Year Batch Active Years 20 @os O1o
- - - T T T T T T AddCus. | | AGICOCs | |RemoveRow | |
I . TCLP Is TCLP Conc. Total Is Total Conc.
I Cl:;:::al Concentration a Detection Limit Concentration a Detection Limit pg:f;';y
(mg/L) (COC is ND)? (mg/kg) (COC is ND)?
I
I
I
I
I
I
I
Figure 3.7  Upper and Lower Panes of the New Project Window
T_ ef COCs Table ?
Clear Al | in: |AICOCs v | |switch Database| 1/1/2009 | Save Cancel
Maximum Oral A
Default COC Chemical Chemical | Contaminant cancer sl
s CAS Level
Version ID name factor
number (MCL) Wima/k
(mg/L) s
1 |0 [J Acetone (2-propanone) 67-64-1 0 0
2 |0 [ Acetonitrile (methyl cyanide) 75-05-8 0 0
3 0 ] Acrolein 107-02-8 0 0
4 0 [ Acrylonitrile 107-13-1 0 0.54
5 0 [C] Benzene 71-43-2 0.005 0.055
6 0 [[] Benzyl chloride 100-44-7 0 0.17
7 {0 ] Bromedichloromethane 75-27-4 0.08 0.062
g8 0 [] Bromomethane (Methyl bromide) 74-83-9 0 0
9 0 [] Butanol n- 71-36-3 0 0
10 0 [] Carbon disulfide 75-15-0 0 0
1 0 [[] Carbon tetrachloride 56-23-5 0.005 0.13
12 N M1 Chlara-1 -hitadisns 2- (Chlaranrens) 1JA-00-2 n n ¥
>
Figure 3.8  Default COC Database Window
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Chemical types (or all chemicals) for the Select All or Clear All buttons may be chosen in
the third box of the tool bar. Clicking on the button a dropdown menu will be displayed.

Clicking on Cancel will close the window.

DRAS 4 can include multiple versions of the COC database. A user may wish to revisit
an older project and test DRAS 4 with the most recent database as well as the database
originally used in the project. The desired COC database may be chosen by clicking on
the Switch Database button. By clicking on this button, the following dialog box will be
displayed (Figure 3.9). A desired version of database may be chosen from the dropdown
menu. Click OK to select the chosen database. The most recent version of the database
will be the default database when using the Add COCs button.

Select All Clear all in: |AlCOCs ¥ | |Switch Database 1/1/2009 Save Cancel
Maximum a
Chemical Contaminant s '
Default COC Chemical e OREMTNNANL | - cancer sl
CAS Level
Version ID name 0 factor
B Select a default database version ? X 1/(mg/kg |
1 0 O 0 |
2 0 i Version: Version 0: DRAS4, 1_EPA Region 5_6/2¢ v 0 |
t
3 [0 i 0 i
4 0 O 0.54
5 0 O 0.055
7 |0 [l 0.062
g 0 (i 0
9 0 [T BUtaneIn- 71353 U 0
10 0 [] Carbon disulfide 75-15-0 0 0
11 0 [] Carbon tetrachloride 56-23-5  0.005 0.13
12 0 M1 Chinrn-1 -hitadiens - (Chlaranrens) 17A-00-28 N n ¥

>

Figure 3.9  Pop-Up Dialog Box for Selecting Database Version (by Clicking on Switch
Database on the Toolbar)

2. (Optional) To add new COCs with customized properties to site COCs, click on Add Cus.
(See more details in Section 3.3.4).

3. To enter site COC concentrations, place the cursor on an empty table cell (Figure 3.10) and
click on the target cell. Note that the concentration cells are preloaded with a zero (0)
entry. DRAS 4 will run with zeros for concentrations. For COCs with zero as the
concentration, back-calculated maximum allowable concentrations will be generated
normally. Forward-calculations of risk and hazard will be run at an automatically
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substituted concentration of 1E-10 (mg/kg or mg/L) in order to avoid an internal error in
the code when processing zeros. Concentrations of 1E-10 mg/kg or mg/L are expected to
be below any level of concern.

To specify whether the input concentrations of a COC toxicity characteristic leaching
procedure (TCLP) and total concentration are estimated from their detection limits (such
as when the COC was not detected), check the box in Columns 3 and/or 5 (Figure 3.10) for
Yes, and the selected multiplier (0.5 or 1.0) will be used. The default values for the two
boxes are No.

To remove a row, highlight the desired row and click on Remove Row.

(Optional) To examine or edit the properties of each site COC, click the cell of the target
COC in Property Details (see the dashed box in Figure 3.10). Once the cell is clicked on
the property table of the chosen COC will be displayed (Figure 3.11). The user can now
edit the required properties. If the properties of any COC are edited, that COC will be
saved as a customized COC. Again, note that the default properties cannot be modified by
the user without the COC becoming classified as a customized COC. Changes to the
default parameters will only happen when new versions of the default database are added
to new versions of the DRAS 4 software by EPA personnel.

# | DRAS 4.0 - [Dialog]
[ File Edit Run Help
New Import Saveas Export

Waste Management Unit Type
(® Landfil
(O Surface Impoundment

Waste Management Unit Active Life

Petitioner

Waste Volume

Createinput Run Results Report

Volume |volume

| |cubic Yards

Manual About

Risk/HQ Values
Cancer Risk Level | 1e-6 v‘\

Hazard Quotient 1.0 V_\

Run with Detection Limit

@® 1YearBatch (O Multiple Year Batch Active Years 20 @05 Owuo
Add Cus Add COCs Remove Row
Charnical TCLP Is TCLP Conc. Total Is Total Conc. E :y eSS
Hama Concentration a Detection Limit Concentration a Detection Limit | De?ails |
(mg/L) (COCis ND)? (mg/kg) (COCis ND)? |
1 Acenaphthene 10 Yes 20 D l Jl

Figure 3.10 Site TCLP and Total Concentrations are Entered in Columns 2 and 4. COC

Properties may be Inspected by Clicking on the Three Dots in the Dashed Area.
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B
=
COC Property:
! a3l
customized
| —— 0
Chemical name Nitroaniline 4-
Chemical CAS number 100-01-6
Maximum Contaminant Level (MCL) (mg/L) 0.0 3
Oral cancer slope factor 1/(mg/kg day) 0.021
Inhalation cancer slope factor 1/(mg/kg day) 0021
Oral reference dose (mg/Kg day) 0.003
Inhalation reference dose (mg/Kg day) 0.0035 -

Bioconcentration factor (L/kg)

Soil saturation level (unitless)

Toxicity Characteristic Rule regulatory level (mg/L)
Henry's law constant (atm-m*3/mol)

Diffusion coefficient in water (cm”2/s)

Diffusion coefficient in air (cm*2/s)

Solubility in water (mg/L water)

Landfill dilution-attenuation factor (unitless)

Figure 3.11 Pop-Up Dialog Box Showing Editable COC Properties

3.3.2.4 Save the Project Database at a User-specified Location

The project database is saved under a default Windows temporary file location, if Save as (on the
toolbar or File > Save as) is not invoked. It is recommended that the Save as option be used. Click
on the Save as button then navigate to a user-desired location, type the user’s project database
name, and click on Save (Figure 3.12). Note that once Save as is invoked the data base changes
subsequent to the invocation will be automatically saved to the new location.

If successful, a confirmation message below will appear. Click OK (Figure 3.13).
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B " Save DRAS Database to a specific location X
<« v A « Region_5 » TEST_20200707 v O

Organize « New folder 2t w e
EPASWMN A Name a Date modified Type
EPACMTP_C
IWEM
KansasCity
LaborTransf
LT2004_Cinr
RecycledWz
References
Region_2

Region_5
v < >

Nawlaw

File name: l m v

Save as type: DRAS sqlite (*.sglite) ~

~ Hide Folders Cancel
Figure 3.12 Pop-Up Dialog Box for Saving Project File

u.'| Dras ﬁ

. . . Successfully saved project database to
E:\Project\DRAS\dras2017\ui_testing\examplel _new_project\test_new.sqlite.
Set this directory as current project directory.

! o ]

= e —— —— ——

Figure 3.13 Confirmation of Successful Saving of Project D

3.3.2.5 Input Petitioner’s Information

This step is optional. Click on Petitioner on the toolbar to input petitioner’s information. Enter
all the required information (see Figure 3.14) then click on OK to save the information to database.
Although optional, the Petitioner tab is very useful in preparing documentation of the DRAS 4 run
for the rulemaking docket. The information entered in this tab will be reproduced on output tables,
serving to clearly identify the petitioned waste, the facility, date, and identify of the person
performing the analysis. Click on Save as to save the entered information.

3.3.2.6 Create Input for the Risk Computational Engine

The user is now ready to generate input for the DRAS risk computational engine. Click on Create
input (lower toolbar in Figure 3.7) to create the risk-computational engine input file called
“DRAS.IN” in the current directory. If the project has been saved to a user-specified directory in
the Save as procedure, the current directory will be the user-specified directory, otherwise, the
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temporary directory will be used to store the file. Click Select Folder to save the “DRAS.IN” file.
Note that “DRAS.IN” is an editable text-based file.

If successful, a confirmation message below will appear. Click on OK (Figure 3.15).

#7 Delisting Petitioner Information ? X

EPARegon: |5 v | EPADeistingPetion Number: [pL4so0 |

Petitioner's Name: | John Smith |

Petitioner's Address: | 1234 Oak Drive |

(Address Line 2) | |

City/State/Zp Code: Lo~
Waste Description: | Waste Stream A |
Waste Code(s): [ 124 I

Analysis Performed by: |Quincy Back |

Date Created: [1/2/2020 |+ Date Submitted to EPA: |2/1/2020 |3

User Comments:

New Project]

[oc ]0 coce

Figure 3.14 Dialog Box for Entering Petitioner’s Information

e = . —
_I'D_
- s i

0 Successfully exported DRASIN to E:
\Project\DRAS\dras2017\ui_testing\examplel_new_project.

Set this directory as current project directory.

Figure 3.15 Confirmation of Successful Creation of Input File for the Risk Computational
Engine
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3.3.2.7 Run the Risk Computational Engine

Click on Run (lower toolbar in Figure 3.7) to execute the risk computational engine. Note that if
the waste volume is not entered or is equal to zero, the Risk Computational Engine will cause the
project run to be terminated and exit from DRAS 4.

The default working directory is where “DRAS.IN” is saved in the previous procedure. A user
may also navigate to any folder that contains “DRAS.IN” and execute the risk computation engine
in that directory.

If successful, a confirmation message below will appear. Click on OK (Figure 3.16).

# | Dras &

T T W

Completed run dras computation.
with project input and output in E:
\Project\DRAS\dras2017\ui_testing\examplel _new_project

' o ]

| - — -

Figure 3.16  Confirmation of Successful Run of Risk Computational Engine

3.3.2.8 Generate Tabulated Results

Click on Results (lower toolbar in Figure 3.7) to import the results from the risk computational
engine. An output file called “DRAS.OUT” is generated by the risk computational engine after
each run and is stored in the current working directory (Figure 3.17). “DRAS.OUT” is a text file
that contains ten output tables from the risk computational engine. Opening the “DRAS.OQUT”
file using the Results tab will display Tables 1-10 in pop-up dialog boxes (Figure 3.18).

The tables within the Results tab can be printed to .pdf or .csv as individual tables or all tables.
Note that the print to file option in the Results tab functions like screen grabs or snapshots and the
print file may appear truncated. Tables and columns can be resized to a degree within the Results
tab prior to printing to .pdf or .csv to minimize formatting issues. In addition, all 10 tables will be
printed if the user chooses to print a report in the Report tab. The tables generated in .pdf and
.html format from the Report tab are preformatted for display and printing as described below in
Section 3.3.2.9. A description of the 10 tables is presented in Table 3.1.
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Orgamze - New folder

3¢ Favorites Name

&) DRAS.OUT

4 Libraries
E’l Decuments
J1 Music
/=] Pictures
=] Subversion
B videos

/% Computer
& osc)
s Data (E)
a FreeAgent Drive (G:)
Lg% GreatNeck (\\DHUANG-LTP) (H:)
s% Modeling 1 (\\mod-nas) (O:)
¢ root (\\mod-nas-02) (P:)
F Lenovo Recoverv (0:)

File name: DRAS.QUT

Figure 3.17 Dialog Box for Importing DRAS.OUT for Post Processing

¥ Results Output 1 X

Teble! Table2 Teble3 Tabled TableS Tebe6  Teble? Tabled Tabe§  Tablelo

Table 1 Surface Pathway Risk
Waste Cancer Risk Cancer Risk ; : Cancer Risk Surface
Chemical Stream Total Surface Water Air Particulate Fancer R'.Sk C_ancel Ri.Sk Air Volatile Pathway
- ; Fish Ingestion Soil Ingestion .
Name Conc, Ingestion Inhalation Pathwa Pathwa Inhalation Pathway Aggregate
(my/kg) Pathuny Pathvay ¥ Y (TCLP-Based for ) Cancer Risk
1 Acenaphthene 20
2 Acrolein 2
3 All Constituents

ntTebe 1toPdf] Save Tale 110 v

PrntAlTbks oPdf Save Ml TakstoCov| | Cose

Figure 3.18 Dialog Box Showing Tables 1 to 10 of the Risk Analysis Results
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Table 3.1

Description of Tables in the DRAS-Generated Report

Table Name

Description

Table 1 - Surface Pathway Risk

Forward-calculation of cancer risks due to releases from the surface of the
waste management unit. Displays risk by individual pathway (fish ingestion,
volatile inhalation, etc.) as well as an aggregate risk by chemical and overall.
Risk estimated from concentrations in petitioned waste.

Table 2 - Groundwater Pathway
Risk

Forward-calculation of cancer risks due to a release to groundwater from the
waste management unit. Displays hazard by individual pathway
(groundwater ingestion, groundwater inhalation, etc.) as well as an aggregate
risk by chemical and overall. Risk estimated from concentrations in
petitioned waste.

Table 3 - Surface Pathway
Hazard Quotient

Forward-calculation of noncancer health effects (hazard) due to releases
from the surface of the waste management unit. Displays hazard by
individual pathway (fish ingestion, volatile inhalation, etc.) as well as an
aggregate risk by chemical and overall. Hazard estimated from
concentrations in petitioned waste.

Table 4 - Groundwater Pathway
Hazard Quotient

Forward-calculation of noncancer health effects (hazard) due to a release to
groundwater from the waste management unit. Displays risk by individual
pathway (groundwater ingestion, groundwater inhalation, etc.) as well as an
aggregate risk by chemical and overall. Hazard estimated from
concentrations in petitioned waste.

Table 5 - Maximum Allowable
Concentrations for Surface
Pathways

Back-calculation of maximum allowable concentrations due to releases from
the surface of the waste management unit. Displays hazard by individual
pathway (fish ingestion, volatile inhalation, etc.). Maximum allowable
concentrations estimated based on target risk and hazard criterion set by the
regulatory authority. Entered waste concentrations are not used in these
calculations. Concentrations will be mg/kg total for landfills and mg/L
leachate for surface impoundments.

Table 6 - Maximum Allowable
TCLP Concentration
Groundwater Pathways

Back-calculation of maximum allowable leachate concentrations, in mg/L,
from releases to groundwater from the waste management unit. Displays
hazard by individual pathway (groundwater ingestion, groundwater
inhalation, etc.). Maximum allowable concentrations estimated based on
target risk and hazard criterion set by the regulatory authority. Entered waste
concentrations are not used in these calculations.

Table 7 - Aggregate Risk and
Hazard Quotient Results

Forward-calculation of aggregate cancer risk and hazard summed across all
pathways and all chemicals. Includes one sum of risk and hazards limited to
COCs that were detected and another sum of risk and hazard that includes
estimates based on the detection limits for COCs that were not detected.
This table summarizes the overall potential risk from the petitioned
waste from COC concentrations in the waste.

Table 8 - Limiting Pathways

Back-calculation of the limiting maximum allowable concentrations based
on target risk and hazard criterion set by the regulatory authority. The
individual limiting pathway is also identified (groundwater ingestion, air
particulate inhalation, etc.). This table is the most concise summary of
maximum allowable concentrations. Note that for surface impoundments,
there will be a maximum allowable leachate concentration in mg/L for both
surface and groundwater pathways.

Table 9 - Pathways Exceeding the
Delisting Limits

This table is a combination of forward- and back-calculations from DRAS.
Although all COCs are included in the table, COCs with waste
concentrations that exceed limiting values are identified when the table also
includes the limiting maximum concentration and pathway.
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Table 3.1 Description of Tables in the DRAS-Generated Report (continued)

Table Name Description
Table 10 - Toxicity This table presents comparisons to alternative criteria. The leachate
Characteristic Soil Saturation concentration of the petitioned waste is compared to the Toxicity
and Ecological Values Characteristic Leachate Procedure concentrations from 40 CFR Part 261.24.

TCLP leachate concentrations that exceed the regulatory values would remain
hazardous regardless of the results of the DRAS model. Total concentrations
in the waste that exceed an estimated soil-saturation concentration indicate
that some of the assumptions used in this assessment may not apply and the
user may need to make additional evaluations of the waste. Predicted surface
water concentrations based on a release from the surface of the waste
management unit are compared to ambient water quality criteria for
protection of aquatic life.

3.3.2.9 Print Results

Click on Report (toolbar) to print the results to files in the .pdf and .html formats. The default
report directory is the user-specified project directory. The user may also choose to navigate to
another folder. A pop-up window (Figure 3.19) will appear when the report is ready. Note that
the Results tab must have been accessed at least once in the current run in order to include output
results in the generated reports under the Report tab.

IrI | Dras ﬁ‘

e — —

Figure 3.19 Confirmation of Successful Generation of PDF- and HTML-Formatted
Reports

3.3.2.10 Qutput Files

Navigate to the project directory to examine output files (Figure 3.20). The user will see two report
files: “dras_report.ntml” and “dras_report.pdf” generated in the previous step. The pdf file is
generated for a quick review of the results. The html file may be opened in a browser to set
customized printing options or it may be copied to MS Word for additional formatting.
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@(Du . «¢ Project » DRAS » dras2017 » ui_testing » examplel_new_project ¢ proje el I
Organize « Include in library ~ Share with + Burn New folder =~ 0 @
M Favorites = Mame : Date modified Type Size
|| DRAS.DBG 8/11/201712:00 PM  DBG File 44 KB
~a Libraries K| DRAS.IN 8/11/2017 11:56 AM  IN File 24 KB
B Documents [E| DRAS.OUT 8/11/201712:00 PM  OQUT File 1KB
JF Music | |¥| dras_report.html 8/11/201712:06 PM  HTML File 24 KB
=| Pictures i ﬁ- dras_report.pdf 811/201712:06 PM  Adobe Acrobat D... 49 KB
=|| Subversion || test_new.sqlite 8/11/201712:02 PM  SQLITE File 61 KB
B videos

Figure 3.20 Location of PDF- and HTML-Formatted Reports

3.3.2.11 Close Current Project

Click on the X icon (or choose File>Exit) at the upper right corner to close the current project
(Figure 3.21). The main window does not support multiple projects. Therefore, the current project
must be closed prior to starting a new project or importing an existing project.

# ° DRAS 4.0 - [Dialog] - O

U File Edit Run Help - B

New Import Saveas Export Petiioner Createinput Run Results Report Manual About

Figure 3.21  Exiting the Project by Clicking on the X Icon (see Arrow)

3.3.3 Import an Existing Project and Run DRAS

3.3.3.1 Importing an Existing Project File

Click on Import in the toolbar or choose File>Import from the toolbar. Note: to avoid
incompatibilities between current project runs and imported projects, users must initiate a fresh
user session for project imports. If DRAS 4 is already running other projects, you must exit the
software and restart to load an existing project by the import function.

A file dialog box (Figure 3.22)will appear to allow the user to navigate to a previous project
database (in .sqlite format). Select the database file and click oin Open in the file dialog box.

A message box below will pop-up if the file import is successful. (Figure 3.23)
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= - <
[ ] Import Customized COCs to project ===
IR ) < Data(E) » Project b DRAS » dalll7 » uitesting » swved projects ___~ [ 9 [ Searchsove e £
Organize ¥ New folder =~ A ®

¢ Favorites Name Date modified

__| dras_LF.sqlite 8/4/2017 5:28 PM
w4 Libraries || dras_SlLsqlite 8/10/2017 6:05 PM
J°f Documents — ) .
Jﬁ Music
= Pictures
=i Subversion
B videos

/& Computer
& osc)
ca Data (E)
& FreeAgent Drive (G:)
¢ GreatNeck (\\DHUANG-LTP) (H:)
5# Modeling 1 (\\mod-nas) (0:)
5# root (\\mod-nas-02) (P:)
F3 Lenovo Recoverv (0:)

File name: dras_SLsqlite - [sqlile (*.sqlite)

\ [

Figure 3.22  Previous Project Databases

Too e

Successfully imported project file from
E:\Project\DRAS\dras2017\ui_testing\saved_projects\dras_Sl.sqlite.

Figure 3.23  Confirmation of Successful File Import

3.3.3.2 Save the Revised Project File

Click on Save as on the toolbar or choose File>Save as from the dropdown menu.

Save the imported project in a different directory to avoid overwriting the existing project file.
Using a new project file name in the existing directory is also permitted. However, the “DRAS.IN”
and “DRAS.OUT?” files will be overwritten.

Note that once Save as is invoked the data base changes subsequent to the invocation will be
automatically saved.

3.3.3.3 Make Revision and Save the Revised Project File

To make arevision to the project and rerun the analysis, follow steps in Section 3.3.2.2 t0 3.3.2.11.
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3.3.4 Customized Chemicals of Concern

Customized COCs are those that are not available in the data base. There are three methods that
can be used to incorporate customized COCs into the project.

e Using available DRAS 4 databases, Section 3.3.4.1.
e Using user-prepared databases, Section 3.3.4.2.
e Directly entering COC identification and properties manually, Section 3.3.4.3.

The process begins by clicking on the Add Cus. button (see the lower dashed frame in Figure 3.8)
to display the window shown in Figure 3.24.

Load COCs | Add New Row | Remove Row Save Al Cancel Al
versionid chemname chemcas mcl csfo csfi ordo ordi bef S |
. 1 Load Data From ? X
b
Data Source ]
@® Default Site COCs Database !

(O User Customized COCs Database (*.sqlite or *.csv)

=

< >

Figure 3.24  Selecting Customized COC Input by Clicking on Add Cus

3.3.4.1 Set Up Customized COCs using DRAS 4 Databases

Users can select a default COC with older database parameters as a customized COC. (Note that
multiple COCs using the exact same name cannot be selected so you cannot have an older and
more recent version of a COC with the same name run at the same time). By clicking on the Load
COCs button on the toolbar, the user will see the Load Data From dialog box. By choosing the
Default Site COCs Database option and clicking on OK the user will see a COC table shown in
Figure 3.25. The user can change the database by clicking on Switch Database. Each database is
identified by the date on which it was created shown to the right of the Switch Database button.
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COCs can be selected by checking the boxes to the left of respective COCs. Once all the required
COCs are selected, click on Save.

B Default COCs Table ? X
Clear All in: |AllCOCs ¥ Switch Database 6/26/2020 Save Cancel
Maximum N
Cheici| Cocmarianiig Oral Inl
Default COC Chemical ETRICEl| COmBEnant) cancer slope can
. CAS Level
Version ID name factor
number (MCL] ‘”(m /kq da ) -”(n_
(mg/) | M9 U
49 0 Methyl isobutyl ketone 108-10-1 0 0 0
50 0 Methyl methacrylate 80-62-6 0 0 0
51 0 [[] Methylene bromide (Dibromomethane) ~ 74-95-3 0 0 0
52 0 D Methylene Chloride (Dichloromethane) 75-09-2 0.005 0.0075 0.001
5 |0 [] Nitrobenzene 98-95-3 0O 0 0
4 0 ] Nitropropane 2- 79-46-9 0 9.4 9.4
5 |0 [] Nitroso-di-n-butylamine N- 924-16-3 0 54 5.6
56 0 [] Pentachloroethane 76-01-7 0 0 0.09
S7 |0 [] Pyridine 110-86-1 0 0 0
58 0 [] Styrene 100-42-5 0.1 0 0
59 0 [] Tetrachloroethane 1,1,1,2- 630-20-6 0 0.026 0.02¢€
AN 0 "1 Tetrarhlarnsthans 112 2- 70-24-5 0 n? no v
< >

Figure 3.25 Default Site Database (Note: Switch Database (see toolbar) can be Used to
Navigate between Databases)

3.3.4.2 Set Up Customized COCs using User-Prepared Databases

By clicking on the Load COCs button on the toolbar, the user will see the Load Data From dialog
box. By choosing the User Customized COCs Database option and clicking on OK (Figure 3.26),
the user will see a dialog box shown in Figure 3.27. Clicking the Switch Database button, the user
will see the Import Customized COCs to Project dialog box. The user must then navigate to the
folder where the database resides. Two database formats are available in DRAS 4, SQL.ite and csv
(Figures 3.28, and 3.29). The chosen database is imported by clicking on Open. COCs can be
selected by checking the boxes to the left of respective COCs (Figure 3.30). Once all the required
COCs are selected, click on Save.

This feature allows the User to import customized chemicals from other projects. The easiest way
to do so is to use the Export function (see File Options section 3.2.1) in the other project. One of
the files exported will be [filename]_Cuscocs.csv. This file contains all the customized chemicals
and will include all the parameters needed to run. We recommend that User’s maintain this file to
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include all their customized chemicals, so they are available for import to any project. This file
could also be easily shared via e-mail to other users.

Load COCs | \Add New Row |Remove Row Save Al Cancel Al

versionid chemname chemcas mcl

csfo csfi ordo ordi bef

Data Source

(O Defauilt Site COCs Database

(®) User Customized COCs Database (*.sglite or *.csv)

o

<

>

Figure 3.26  Selecting Customized COC Input from User-Prepared Databases

Select All Clear All in: |All COCs ¥  |Switch Database 1/1/2009 Save Cancel

Figure 3.27 Dialog Box for Inputting User-Prepared Databases
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® " Import Custemized COCs to project X
« A > ThisPC » OS({C:) » Projects » EPA Projects 3 Region 5 » DRAS 4.0 v & 2 Search DRAS_4.0
Organize ¥ Mew folder ==« [H o
A
~ Name Date modified Type Size
3 Quick access
OldVersions 7/9/2020 1:58 PM File folder
[ Desktop - ; :
m CustomCOCDatabase.sglite /2020 9:06 PM SQLITE File 158 KB
& Downloads 8 CustomCOCDatabase_ chemdb_w._cusco... 2020 %:06 PM SOLITE File 158 KB
Documnents 8 test1sqlite 2020 3:13 PM SQLITE File 60 KB
[&] Pictures -
DRAS 4.0
Report
sqlite
SV2_recoverylc
@ OneDrive
[ This PC
) 3D Objects
[ Desktop
File name: |CustomCOCDatabase.squte v| sglite (*.sqlite) i
Figure 3.28 Selecting a User-Prepared SQL ite-Formatted Database
.
&« v o > ThisPC » OS(C:) > Projects > EPA_Projects » Region_5 > DRAS_4.0 v O Search DRAS_4.0
Organize v New folder = v [H
o) Name Date modified Type Size
# Quick access
QldVersions 7/9/2020 1:58 PM File folder
B Desktop * ) ) -
@ CSVDatabase _with_Custom_COC_Fields.... 7/7/2020 851 PM Microsoft Excel C... 1KB
*
“'f Downlasds £ Custom_COC.csv 7/9/2020 10:09 PM Microsoft Excel C... 2KB
= Documents £33 test1_Cuscocs.csv 7/9/2020 3:54 PM Microsoft Excel C... 1KB
&= Pictures o E33) test1_Petitionerinfo.csv 7/9 Microsoft Excel C... 1KB
DRAS_4.0 @ test1_Sitecocs.csv 779/ Microsoft Excel C... 1KB
Report E37) test1_Wmu.csv 7/9/2 Microsoft Excel C... 1KB
sqlite
SV2_recoverylc
@ OneDrive
[ This PC
-3 3D Objects
Il Desktop
File name: |Custom_COC.csv v] csv (*.csv)
Open Cancel

Figure 3.29  Selecting a User-Prepared CSV-Formatted Database
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' Default COCs Table ? X
Select All Clear Al in: Al COCs ¥ | |Switch Database 1/1/2009 Save Cancel
versionid chemname chemcas mcl csfo csfi ordo ordi  bcf soilsat tc  henry  diffw d

1 3 (] EPA1,1,1 999-99-1 0 0 0 09 315 04 100000 O 2.88e-05 1.15e-05 0|
23 (] EPA1,1,2 999-99-2 0 0 0 0.017 0.0595 0.325 190000 O 24e-05 1.5e-05 0
33 (] EPA1,1,3 999-99-3 0 0 0 0.0005 2e-05 0.58 43000 0 9.34e-05 1.22e-05 0|
43 EPA1,1,4 999-99-4 0 0 0 0.0005 2e-05 0.58 43000 0 9.34e-05 1.22e-05 0|
< > |

Figure 3.30 Example of a User-Prepared Database

3.3.4.3 Enter COC information Manually

Each time the user clicks on Add New Row on the Customized COCs toolbar in Figure 3.24, a
blank line will appear. COC information can then be entered by the user as shown in an example
in Figure 3.31. COCs can be selected by checking the boxes to the left of respective COCs. Once
all the required COCs are selected, click on Save. Only the chosen COCs will be saved in the
project file.

If the user does not have a dilution-attenuation factor (DAF) for the customized chemical, entering
zeros for both the landfill DAF (DAFLF) and surface impoundment DAF (DAFSI) will prompt
DRAS 4 to automatically substitute the most conservative (minimum) DAFs from the default COC
database, 15.1 for DAFLF and 3.18 for DAFSI.

B " Default COCs Table ? X
Select All Clear All in: |AllCOCs ¥ Switch Database 1/1/2009 Save Cancel
versionid- chemname chemcas mcl c¢sfo csfi ordo ordi  bef soilsat  tc henry diffw d

13 [ EPA1,1,1 999-99-1 0 0 0 0.8 315 04 100000 O 2.88e-05 1.15e-05 0.!

|2 3 [J erA1,1,2 999-99-2 0 0 0 0.017 0.0595 0.325 190000 0 2.4e-05 1.5e-05 (J.I

133 [] EPA1,1,3 999-99-3 0 0 0 0.0005 2e-05 0.58 48000 0 9.34e-05 1.22e-05 UJ;

Figure 3.31 Example of Manually Input COC Data
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APPENDIX A
APPLICATION EXAMPLE

A.l  Overview

The example shown below is that of a proposed waste stream with three COCs for landfills. The
application consists of three stages: data input (Section A.2), running the risk computational engine
(Section A.3), and result output/reporting (Sections A.4 and A.5). For each stage, relevant
instructions in Section 3 are referred to.

A.2  Enter WMU and COC information

Following the instructions in Sections 3.3.2.1 to 3.3.2.3 for the WMU and the first two COCs, and

the instructions in Section 3.3.4 for the last COC (EPA 1,1,3) results in the populated window
shown in Figure A.1.

B DRAS 4.0 - [Dialog] — O X
[T File Edit Run Help -8 x
Mew Import Saveas Ewxport Petitomer Createinput Run  Results Report  Manual  About
Waste Management Unit Type Waste Volume Risk/HQ Values
(®) Landfil Cancer Risk Level
Volume | 1000 Cubic Yards ~
() surface Impoundment Hazard Quotient

Waste Management Unit Active Life

Run with Detection Limit

(® 1vear Batch () Multiple Year Batch Active Years |20 ®os (Lo
Add Cus. Add COCs Remave Row
Chernical TCLP TCLP Conc. Below Total Total Conc. Below Property
Narne Concentration Detection Limit Concentration Detection Limit Defails
{mg/L Yes/MNo {mg/kg) Yes/MNo
1 Acrolein 10 1 Me 10 [ Me
2 Benzene 10 1 Me 10 [ Mo
3 EPA1,1,3 10 A Ves 10 Ves
Figure A1  WMU and COC Information Input

U.S. EPA Region 5
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Following the instructions in Section 3.3.2.5, petitioner’s and other related information is entered
resulting in the window shown in Figure A.2.

B ' Delisting Petitioner Information ? x

EPA Region: 1 = | EPA Delisting Petition Mumber: |DL-99933

Petitioner's Name: |J|:|hn Q. Adams

| Petitioner's Address: | 20145 Regan Street

City/State/Zip Code: |F‘El:|ria IL = |B1559

Waste Description: |Inu:|ustria|

Waste Code(s): |Nl.-',-5.

|
|
|
(Address Line 2) | |
|
|
|
|

Analysis Performed by: |T|:um Maddox

Date Created: 1/1/2017 + | Date Submitted to EPA: | 1/1/2017 S

User Comments:

MNone

Cancel

Figure A.2  Petitioner’s and Waste’s Information

A.3  Create Input File and Run

The DRAS.IN file (input file for the risk computational engine) is then created based on the
instructions in Section 3.3.2.6. Following the instructions in Section 3.3.2.7, the risk
computational engine is run to create the DRAS.OUT file. The results are ready to be post-
processed.

A.4  Tabulated Output

Following the instructions in Section 3.3.2.8, tabulated results shown in Figure A.3 are created.

U.S. EPA Region 5
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B Results Qutput

Table 1 Table2  Table 3 Table 4 Table 5 Table 6 Table 7 Table 8 Table 9 Table 10

Table 1 Surface Pathway Risk

Waste Cancer Risk Cancer Risk Cancer Risk
Chemical Stream Total Surface Water Air Particulate X
X Fish Ingestion
MName Conc. Ingestion Inhalation Pathwa
(mg/Kg) Pathway Pathway ¥
1 Acrolein 10 --- - -
2 Benzene 10 2.2%e-13 3.07e-13 4.5e-12
3 EPA113 5 --- - -
4 All Constituents 2.2%e-13 3.07e-13 4.5e-12

Cancer Risk
Soil Ingestion
Pathway

Cancer Risk

Air Volatile
Inhalation
Pathway

Surface
Pathway
Aggregate
Cancer Risk

Print Table 1 to Pdf| |Save Table 1to Csv

Print All Tables to Pdf | Save All Tables to Csv

Close

Figure A3 Result Tables 1 to 10.

U.S. EPA Region 5
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A5 Tabulated Output

Following the instructions in Sections 3.3.2.9, and 3.3.2.10, two report files (dras_report.html and
dras_report.pdf) are created in the working directory. A pdf file can also be created by saving the
html file as a pdf file. An example of such file is appended to the end of this section.

U.S. EPA Region 5
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https://3.3.2.10

Page 1 of 17

DRAS Report

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020


file:///C:/Projects/EPA_Projects/Region_5/DRAS_4.0/Applications/dras_report.html

Petitioner Information

Page 2 of 17

EPA Region

5

[EPA Delisting Petition Number

[DL-9949

[Name

John Q. Adams

[Address 2202 Sleep Hollow Road
[Address Line 2

City Odell

State 1L

Zip Code 60460

[Waste Description Industrial

[Waste Code (W-1234

[Analysis Performed by: [Matt Mendoza

[Date Created: 1/1/2017

[Date Submitted to EPA 1/1/2017

[User Comments

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html

7/30/2020


file:///C:/Projects/EPA_Projects/Region_5/DRAS_4.0/Applications/dras_report.html

Page 3 of 17

WMU Information
Unique Site Identifier 0
[Landfill (LF) or Surface Impoundment (SI) LF
Risk Factor le-06
[Hazard Quotient Factor 1.0
[Annual Waste Volume 1000.0
[Units for Waste Volume 0-yd"3 1-ft"3 2-m"3 0
Active Life of the Waste Management Unit (years) 1.0
[Run Detection Limit at Half (0.5) or Full Level(1.0) 1.0

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020



Table 1 Surface Pathway Risk

Page 4 of 17

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html

Chemical Waste Stream Cancer Risk Cancer Risk Air Cancer Risk [Cancer Risk Soil| Cancer Risk Air Volatile | Surface Pathway
Name Total Conc. Surface Water Particulate Fish Ingestion Ingestion Inhalation Pathway Aggregate Cancer
(mg/kg) Ingestion Pathway | Inhalation Pathway Pathway Pathway (TCLP-Based for SI) Risk
Acrolein 1.000E+01 -—- - --- --- -—- ---
[Benzene 1.000E+01 2.290E-13 3.190E-13 4.500E-12 0.220E-13 2.350E-11 2.950E-11
[EPA 1,1,3 |1.000E+01 - -—- - --- --- ---
All 2.290E-13 3.190-13 4.500E-12 0.220E-13 2.350E-11 2 950E-11
Constituents
7/30/2020
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Table 2 Groundwater Pathway Risk

Page 5 of 17

Dilution Waste Waste Cancer Risk Cancer Risk Cancer Risk Cancer Risk Groundwater
Chemical Attenuation Volume Stream Groundwater Groundwater Groundwater Groundwater Pathway
Name Factor (DAF) Adjusted | TCLP Conc. Ingestion Inhalation Dermal Absorption | Dermal Absor]?tion Aggrega?e Cancer
DAF (mg/L) Pathway Pathway Pathway-Adult Pathway-Child Risk
Acrolein --- - 1.000E+01 --- - --- --- -
Benzene 1.540E+01 2.140E+03  |1.000E+01 3.520E-06 3.390E-06 4.060E-07 1.770E-07 7.320E-06
[EPA 1,1,3 |- - 1.000E+01 --- - --- - -
All . 3.520E-06 3.390E-06 4.060E-07 1.770E-07 7.320E-06
Constituents
file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020
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Table 3 Surface Pathway Hazard Quotient

Page 6 of 17

. Waste Stream | Hazard Quotient | Hazard Quotient Air | Hazard Quotient| Hazard Quotient Hazart‘i Quotlent‘ Air Surface Pathway
Chemical N . . . . . Volatile Inhalation
Total Conc. Surface Water |Particulate Inhalation| Fish Ingestion Soil Ingestion Aggregate Hazard
Name . Pathway (TCLP-Based N
(mg/kg) Ingestion Pathway Pathway Pathway Pathway for SI) Quotient

Acrolein 1.000E+01 1.620E-08 3.990E-06 9.700E-09 2.970E-07 7.410E-04 7.450E-04
Benzene 1.000E+01 2.030E-09 2.660E-09 5.120E-08 3.710E-08 1.970E-07 2.890E-07
[EPA 1,1,3 |1.000E+01 1.620E-08 3.990E-06 9.700E-09 2.970E-07 7.410E-04 7.450E-04
All . 3.450E-08 7.990E-06 7.060E-08 6.310E-07 1.480E-03 1.490E-03
Constituents
file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020
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Table 4 Groundwater Pathway Hazard Quotient

Page 7 of 17

. Waste Dilution Waste Hazard Quotient Hazard Quotient | Hazard Quotient Hazard Quotient Groundwater
Chemical Stream Attenuation Volume Groundwater Groundwater Groundwater Groundwater Pathway
Name TCLP Conc. Factor (DAF) Adjusted Ingestion Pathway Inhalation Dermal Absorption | Dermal Absorl.)tion Aggregate. Hazard
(mg/L) DAF Pathway Pathway-Adult Pathway-Child Quotient

Acrolein 1.000E+01  |--- --- 3.840E-30 2.000E-28 1.970E-32 4.280E-32 2.040E-28
Benzene 1.000E+01 1.540E+01 2.140E+03  |3.120E-02 2.830E-02 4.610E-03 1.010E-02 6.960E-02
[EPA 1,1,3 [1.000E+01  |--- - 3.840E-30 1.480E-28 1.970E-32 4.280E-32 1.510E-28
All . 3.120E-02 2.830E-02 4.610E-03 1.010E-02 6.960E-02
Constituents
file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020
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Table S Maximum Allowable Concentrations for Surface Pathways

Max Allowable

Max Allowable

Max Allowable

Page 8 of 17

Max Allowable Total
Conc. (mg/kg) for LF and

Delisting Level: Limiting| Max Allowable

. |Waste Stream| Maximum Allowable Total Conc. Total Conc. Air . X

C;e;n;gal Total Conc. | Total Conc. (mg/kg) for | Surface Water Particulate Totz;:‘gCe(;;lianlsh Tot;xlllgCe(s):liz.nSml TCLP Conc. (mg/L) for
(mg/kg) LF and TCLP Conc. |Ingestion Pathway | Inhalation Pathway Pathway (mg/kg)| Pathway (mg/kg) SIL. Air Volatile
(mg/L) for SI (mg/kg) (mg/kg) Inhalation Pathway

Acrolein |1.000E+01 1.350E+04 6.160E+08 2.510E+06 1.030E+09 3.370E+07 1.350E+04
Benzene |1.000E+01 4.250E+05 4.360E+07 3.140E+07 2.220E+06 1.080E+07 4.250E+05
EPA 1,1,3 [1.000E+01 1.350E+04 6.160E+08 2.510E+06 1.030E+09 3.370E+07 1.350E+04

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html

7/30/2020


file:///C:/Projects/EPA_Projects/Region_5/DRAS_4.0/Applications/dras_report.html

Page 9 of 17

Table 6 Maximum Allowable TCLP Concentration Groundwater Pathways

Limitin Delisting Max Allowable | Max Allowable Max
Waste nang o Level: Max Allowable | Max Allowable | Receptor Conc. | Receptor Conc.
Maximum | Dilution Waste RN Allowable
. Stream . Limiting | Receptor Conc. | Receptor Conc.| Groundwater Groundwater
Chemical Allowable | Attenuation| Volume R Receptor
TCLP . Maximum | Groundwater | Groundwater Dermal Dermal
Name Receptor Factor Adjusted . . . . Conc.
Conc. Conc (DAF) DAF Allowable Ingestion Inhalation Absorption Absorption MCL
(mg/L) (m /I.:) TCLP Conc.|Pathway (mg/L)|Pathway (mg/L)| Pathway-Adult | Pathway-Child (mg/L)
& (mg/L) (mg/L) (mg/L) &
Acrolein |1.000E+01 [3.600E-04 [--- --- 4.990E+28  |1.880E-02 3.600E-04 3.670E+00 1.680E+00 -
Benzene |[1.000E+01 [1.330E-03 [1.540E+01 |2.140E+03 |2.840E+00 [1.330E-03 1.380E-03 1.150E-02 2.650E-02 5.000E-03
EPA 1,1,3]1.000E+01 |4.890E-04 [--- --- 6.780E+28  |1.880E-02 4.890E-04 3.670E+00 1.680E+00 -—-

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020



Table 7 Aggregate Risk and Hazard Quotient Results

Page 10 of 17

. Aggregate Hazard Aggregate Hazard ., | Aggregate Cancer Total
Chemical Name Chemical Index Groundwater Index Surface Total Aggregate) Aggregate Cancer Risk Risk Surface Aggregate
CAS number Hazard Index |Groundwater Pathways .
Pathways Pathways Pathways Cancer Risk

Acrolein 107-02-8 2.040E-28 7.450E-04 7.450E-04 --- --- ---
Benzene 71-43-2 6.960E-02 2.890E-07 6.960E-02 7.320E-06 2.950E-11 7.320E-06
[EPA 1,1,3 999-99-3 1.510E-28 7.450E-04 7.450E-04 --- --- ---
Sum-Detected 6.960E-02 7.460E-04 7.030E-02 7.320E-06 2.950E-11 7.320E-06
[COCs Only
Sum-with Non-
Detected COCs 6.960E-02 1.490E-03 7.110E-02 7.320E-06 2.950E-11 7.320E-06
file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020



Table 8 Limiting Pathways

Page 11 of 17

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html

Chemical Chemical CAS GW Path Limiting TCLP Limiting GW | Surface Path Limiting Conc. (mg/kg Total for LF,| Limiting Surface
Name number Conc. (mg/L) Pathway mg/L TCLP for SI) Pathway
Acrolein [107-02-8 4.990E+28 GW Inhalation  |1.350E-+04 Air Volatile
Inhalation
Benzene  |71-43-2 2 840E+00 GW Ingestion  |4.250E+05 Air Volatile
Inhalation
. Air Volatile
[EPA 1,1,3 999-99-3 6.780E+28 GW Inhalation 1.350E+04 .
Inhalation
7/30/2020
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Table 9 Pathways Exceeding the Delisting Limits

. . Waste Stream s s Surface Path Waste Conc. | Surface Path Limiting Conc.| Limitin,
C;";‘I::“' ngﬁﬁﬂer TCLP Conc. TGC‘Z;) act;‘n';f‘(‘“l‘:é;‘f) L“l‘,‘;‘li‘vgvsw (mg/kg Total for LF, mg/L | (mg/kg Total for LF,gmg/L Surface
(mg/L) TCLP for SI) TCLP for SI) Pathway
Acrolein 107-02-8 1.000E+01 - -- 1.000E+01 --- --
Benzene  [71-43-2 1.000E+01 2.840E+00 (GW Ingestion |1.000E+01 -—- --
[EPA 1,1,3 999-99-3 1.000E+01 -—- -- 1.000E+01 - --

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020
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Table 10 Toxicity Characteristic Soil Saturation and Ecological Values

Chemical | Chemical Allowable Toxicity Waste Stream Allowable Soil Surface Path Waste Conc. Allowable Predicted
Name |CAS number Characteristic Conc. TCLP Conc. Saturation Conc. | (mg/kg Total for LF, mg/L | Aquatic Conc. | Ambient Conc.
(mg/L) (mg/L) (mg/kg) TCLP for SI) (mg/L) (mg/L)
Acrolein  |107-02-8 -—- 1.000E+01 4.800E+04 1.000E+01 2.100E-03 3.140E-08
Benzene  |71-43-2 5.000E-01 1.000E+01 9.000E+02 1.000E+01 4.600E-02 3.140E-08
[EPA 1,1,3 [999-99-3 --- 1.000E+01 4.800E+04 1.000E+01 2.100E-03 3.140E-08
7/30/2020
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Site COCs - Part 1

Is TCLP Is Total
Conc. a Conc. a Default
(Chemical TCLP . _|Detection| Total . _[Detection/Property] COC . o Created
Concentration| . .~ |Concentration| . . . . Version Description Creator
name (mg/L) Limit (mg/kg) Limit | Details [Version Date
8 (COC is gk8  1(cocis D
ND)? ND)?
Acrolein [10.0 No 10.0 [No 0 0
[Benzene [10.0 No 10.0 [No 0 0
2020-
[EPA Imported from
L3 |00 Yes 100 Yos  pous3 3 C:/Projects/EPA_Projects/Region_S/DRAS_4.0/Custom COC (2);2(1)03 dguvanasen

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020
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Site COCs - Part 11

Maximum Oral cancer |Inhalation cancer Oral Inhalation Toxicity
Chemical . Bioconcentration [Soil saturation] Characteristic Rule
name Contaminant Level [slope factor 1/| slope factor 1/ |reference dose| reference dose factor (L/kg) level (unitless) regulatory level
(MCL) (mg/L) | (mg/kg day) | (mg/kgday) | (mg/kgday) | (mg/kgday) (mg/L)
Acrolein  [0.0 0.0 0.0 0.0005 2e-05 0.58 48000.0 0.0
Benzene [0.005 0.055 0.02808 0.004 0.03 24.48 900.0 0.5
[EPA 1,1,3 (0.0 0.0 0.0 0.0005 2e-05 0.58 48000.0 0.0

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html 7/30/2020
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Site COC:s - Part 111

Page 16 of 17

file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html

. Henry's law Diffusion Diffusion Solubility in | Landfill dilution- | Surface impoundment | Time to skin Skin
Chemical S S . R . e .
name constant coefficient in | coefficient in | water (mg/L |attenuation factor| dilution-attenuation permeability permeability
(atm-m”3/mol) | water (cm”2/s) | air (cm”2/s) water) (unitless) factor (unitless) (hr/event) constant (cm/hr)

Acrolein  ]0.00014 1.22¢-05 0.11 213000.0 le+30 le+30 0.46 0.00085

Benzene |0.0059 9.8e-06 0.088 1750.0 15.4 3.18 0.63 0.021

[EPA 1,1,3 |9.34¢-05 1.22¢-05 0.11 213000.0 le+30 1e+30 0.46 0.00085

7/30/2020
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Site COCs - Part IV
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file:///C:/Projects/EPA Projects/Region 5/DRAS 4.0/Applications/dras report.html

Susl?ended Logarithmic
. sediment-
Lag| Bunge |Flag 1= organic Chronic Fla, Molecular| Vapor surface value of
Chemical| .8 g g g Bioaccumuation| ecological 28 R P octanol/water |Chemical|Analytical
time| constant (Carcinogen/ | weight |pressure water sl
name . . . | factor (L/kg) value . e L partitioning Method
(hr) | (unitless)| metal/inorganic Noncarcinogen)| (g/mol) | (atm) | partitioning .
(mg/L) . coefficient (log
coefficient (mL/g))
(mL/g) 5
. . 8260D,
Acrolein 0.19(9.8e-05 0.0 0.0021 Noncarcinogen [56.1 0.35 0.0882 -0.01 R015C
8260D,
Benzene [0.26]0.013 0.0 0.046 Carcinogen 78.1 0.125 4.65 2.13 8015C,
8021B
EPA . 8260D
113 0.19(9.8e-05 0.0 0.0021 Noncarcinogen |56.1 0.35 0.0882 -0.01 R015C
7/30/2020
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